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1.0 Overview and Navigation
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Astra Schedule has an intuitive look and feel that will allow you to become familiar with its features quickly. Additionally, many facets of the user interface can be customized. The CSUB guide only includes the information for features that are currently used by the campus.  Additional features may be added in the future.  Astra Schedule online help will connect you to the full, 14-Chapter, Astra Schedule 6.0 User’s Guide.
To launch Astra Schedule, double-click on the ‘Astra Schedule’ shortcut icon on your desktop.  
Note: The Astra Schedule program files reside on your C:\ drive in a folder named “AdAstra.” The Astra Schedule main user interface window will appear.

Image of the Astra Schedule page showing sections, events, rooms, and exam tabs
Upper Toolbar 
         Pull Down Menus

    Lower Toolbar     Group By Option 
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Grid Tabs 


Group By Option 
Data Grid displays Section, Room, or Event data in a spreadsheet style format.  Group tabs group data by fields as selected from the Group By Option.
Pull-Down Menus – Group together common functionality across the top of the screen
Upper Toolbar – Contains shortcuts to most commonly used functions.
Grid Tabs – Display the underlying data from Section, Event, Room and Exam tables.
Lower toolbar – Includes data navigation tools and other data utilities. The toolbar icons vary with the selected Grid Tab. 
Group By option – Groups the displayed records on a particular field. The groups are displayed as tabs at the bottom of the screen. The Jump To list takes the user directly to that Group tab.
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Terms: The Terms included in the date range that academic schedules are viewing. Records Count: Indicates how many Records are in the current grid view. Level: Indicates the access level associated with your User account. Date and Time: The date and time as set-up in Windows

2.0 Using the Toolbars

2.1 Upper Toolbar 

The upper toolbar is located at the top of the screen directly below the drop-down menus. The buttons in the upper toolbar are shortcuts to the most commonly used functions. You can mouse over the icon to identify the function.

[image: image4.emf]                                                                                                                                                

The following table summarizes the function of the various upper toolbar icons: 
	Toolbar
	Rollover Hint
	Icon
	Function

	File


	Select date range to review
	[image: image5.emf]
	Select a term and/or date range of section data to view. You may choose to view one term at a time or a date range that encompasses one or more terms. 

	
	Switch to Scenario Modeling Mode
	[image: image6.emf]
	Not currently used by California State University San Bernardino. 

	
	Standard Reports
	[image: image7.emf]
	Configure, preview, and print standard reports.

	
	Exit the application
	[image: image8.emf]
	Exit the Astra Schedule application. 

	
	Message Center
	[image: image9.emf]
	Compose, view, and send messages through Astra Schedule. Not currently used by California State University San Bernardino.

	
	Set Event Display Cutoff Date 
	[image: image10.emf]
	Filter that determines which events are displayed in the events tab. 

	Preferences


	Preferences On
	[image: image11.emf]
	Activate a filter that will allow you to view only those sections without preferences. 

	
	Turn Preferences Off
	[image: image12.emf]
	Deactivate the Filter Preferences On feature. 

	Database
	Edit Record
	[image: image13.emf]
	Edit the selected record in the active grid/tab. Not available to all users.

	
	Database Layout
	[image: image14.emf]
	Define which fields are visible in the active tab. 

	Assignments
	Daily Room Grid
	[image: image15.emf]
	View the daily room grid of room bookings in the entire system for one day. 

	
	Weekly Room Grid
	[image: image16.emf]
	View the weekly room grid of room bookings in the entire system for one week.

	
	Monthly Events
	[image: image17.emf]
	View a calendar of all events and related resource notifications for an entire month. 

	
	Instructor Grid
	[image: image18.emf]
	A view of a selected faculty members schedule for one week. 

	
	Event Wizard
	[image: image19.emf]
	Create a new event using the Event Wizard. Available to Event Schedulers. 

	
	Optimizer
	[image: image20.emf]
	Not currently used by California State University San Bernardino. 

	
	Resources
	[image: image21.emf]
	Display the resources grid view of resource inventory and bookings. 


2.2 Customizing the Upper Toolbar

The toolbar at the top of the Astra Schedule interface may be customized to include various buttons.  Any tool that you access in Astra Schedule from the drop-down menus at the top of the user interface may be added to the toolbar as a button for easier access.

Follow the steps below to add or remove buttons from the Upper Toolbar:
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Click on any of the down-directional arrows in the upper toolbar to display a drop-down Add or Remove Buttons dialog box. Image of a drop down menu 

[image: image67.jpg]


Select “Customize…” to display the Customize dialog box.

The Toolbars tab allows you to toggle on and off the default toolbars in Astra Schedule.  

Clicking “New…” allows you to create and name your own new blank toolbar.  After creating a new toolbar, it can be clicked, dragged, and dropped at the top of the main user interface window. Then, using the Commands tab in this dialog box, you can add new buttons to any existing or new toolbars.
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The Commands tab displays a list of the various Astra Schedule drop-down menus on the left, and selecting one of them displays their individual menu items on the right. To add one of those menu choices as a button on one your toolbar, simply left click and hold an option on the right, drag the icon to the top of the main user interface window, and drop it in an existing toolbar.
The Options tab will allow you to set various display options to fine tune the way your Astra menu options are displayed.

Image section of the customize page showing the commands tab and also the options tab.
2.3 Lower Toolbared just below the grid tabs. 
The lower toolbar is located just below the grid tabs. 
[image: image22.emf]
Additional Event Icons: [image: image23.emf] 
The following table summarizes the function of the various lower toolbar icons: 

	Rollover Hint
	Icon
	Use to …

	Go to First Row 
	[image: image24.emf]
	Go to the first record in the active tab. 

	Previous Row 
	[image: image25.emf]
	Go to the previous record in the active tab. 

	Next Row 
	[image: image26.emf]
	Go to the next record in the active tab. 

	Go to Last Row 
	[image: image27.emf]
	Go to the last record in the active tab. 

	Remove Sorts 
	[image: image28.emf]
	Clear sorts from all columns in the active tab. 

	Export Grid 
	[image: image29.emf]
	Export data being displayed in the grid to an Excel file. 

	Print Grid 
	[image: image30.emf]
	Print the visible data in the active tab. 

	Refresh Grid 
	[image: image31.emf]
	Refresh the data in the active tab. 


2.4 The Tabs
[image: image32.png]



The body of the main user interface window is a spreadsheet-like grid, consisting of four main tables referred to as tabs.
Sections Tab: A list of all academic sections

Events Tab: A list of all events, academic and non-academic, on campus

Rooms Tab: A list of schedulable space on campus

Exam Tab: A list of all academic sections that have exam data posted for the term 

The tabs, located at the top left corner of the window, allow you to navigate between the Section, Event, Rooms, and Exam tables. Click on the tab corresponding to the table you wish to view. The selected tab and corresponding data will appear. A subset of tabs corresponding to specific campuses will allow you to view the Sections, Rooms, Exams, and Events associated with multiple campuses.
2.5 Records vs. Fields
When viewing the tabs, keep in mind that each row represents a database record and each column represents a field in the database.

2.6 Color Codes

The records in the tabs are color coded by status. These color-codes can be viewed and customized in the Color Options table accessible in the Database | Color Options drop-down menu. Color options allow you to easily see a section’s status by color-coding the records. The options can be viewed by accessing the Database menu and selecting Color Options. The default options are given below. 

Example – Sections:
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2.7 Status Codes Definitions

Scheduled: A section or event that has a building and room assigned to it.

Requested: A section or event with a building and room which has been requested by a User without access; or a building and room assignment has been passed forward by your SIS that Astra Schedule does not recognize.

Do Not Schedule: A section that has invalid Days Met, times, or dates; or a section that has been manually selected as Do not Schedule.
Unscheduled: A section or event without a building and room assigned.

Incomplete: A section that is missing required data.

Declined: A section or event that has had a room request declined.

Cancelled: A section or event that has been cancelled.

Cross Listed: A section that meets in the same room at the same time as one or more other sections.

Overbooked: A section’s max enrollment is larger than the capacity of the room to which it is assigned.

Not Available (Room): A room that has already been scheduled for another event or section.

Room Blocked: A room that has been taken off-line.

Room Controlled: A room that has a scheduling constraint.

Request Only (Room): A room that is only available for requesting.

Tentative (Event): An event that does not have a building and room assigned to it; or, a scheduled event has been manually changed to tentative.

Available (Resource): A resource that is available to be checked out.

Should be checked out (Resource): A resource that has been requested for a particular time but has not yet been checked out.

Checked Out (Resource): A resource that is checked out.

Past Due Check In (Resource): Status Codes: A resource that is past due.

Checked In & Out (Resource): A resource that has been checked in and out.It will return to available status on the following day.

2.8 Sort Feature

You may sort the active tab (table) by any column (field). Sorts may be performed on a single column.
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Follow the steps below to perform a sort:

Click on the gray column header (field name – in this example, “Title”).  The data will then be sorted in ascending order by that column header (field) and a corresponding directional arrow appears beside the header.
Click on the same column header again. The data will be sorted in descending order by that column header and a corresponding directional arrow appears beside the header.

Note: You may right click to perform a descending sort.

Use Shift key and Click on multiple column headers to sort again to sort more than one column of data. Image of icon showing the numbers, 1, 2 and 3 in the middle
Note: Use the [image: image34.png]


 icon to remove the sort.
2.9 Grouping Feature

You may group the data on your active tab by any column of data. 

Follow the steps below to perform a customized sort: Image of group data in an active column area
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Click and drag a gray column header to the gray grouping area, (which states “Drag a column header here to group by that column”) directly below the “Campus” tabs. This will group your data in the grid by the field that you have chosen (in this example, “Subject”).
[image: image71.png]


Click the expand icon next to the desired group to view the individual records in that group (in this example, “Subject: AGBS”).
Dragging a second column to the grouping area will perform a secondary grouping of your data on the (grid in this example, “Course”).

You may continue adding as many groups as you need (e.g. “Section Number”, etc).

To clear all groupings and reset the data, simply drag all column headers back to the grid.
2.10 Find Feature

You may perform a “find” or look-up on any column for a particular value. 

Follow the steps below to find a value in a column:
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Click the down directional arrow beside any column header to display a list of all items in that column (in this example, “Subject”). You can use this list to filter the grid. Image of column 

Select “Custom…)” from the list to display the Custom Filter search dialog box.
[image: image73.png]





Select the desired argument (example “like,” “does not equal,” etc.), from the first drop-down menu. Enter the value by which you wish to filter in the field next to this drop-down menu.

Select OK and the grid will be filtered to show only the fields selected in the dialog box.

3.0 Customizing Astra Schedule Views 

Astra Schedule provides many tools that allow you to personalize the “look and feel” of the application.

3.1 Database Layout Tool

The way the data in the active tab appears on your screen can be customized to meet your needs. Follow the steps below to use the Database Layout tool: Image of the layout icon showing tools in the middle
Click the Database Layout icon [image: image35.png]


 in the upper toolbar you may also select Database | Database Layout. The ‘Database Layout’ dialog box will appear. Clicking on a field in either panel highlights the panel you wish to move.  

Click the right (blue) directional arrow to move fields from the “Fields Not Displayed” panel to the “Fields Displayed” panel. Click the left directional arrow to move fields from the “Fields Displayed” panel to the “Fields Not Displayed” panel.  Image of database layout
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To view your fields in a certain order, click and drag any field (up or down) to the desired position.

Note: You may also drag and drop the fields. Hold the “Ctrl” key while highlighting fields to select more than one field at a time. Image of sheet of paper with a pencil on the side 

To edit a field’s display label, highlight the field and click the Edit [image: image37.png]


 button.  Make your desired edits and click OK to finish.  

User Fields have been used to map information from PeopleSoft to Astra Schedule. The following is a list of what those fields are used for. The ones highlighted in red are user fields that may be the most useful:

USER 1 through 4 are used for synchronizing the exam functionality with PeopleSoft

USER 5 is the course offer number

USER 6 is the course ID
USER 7 is the combined sections ID
USER 8 is UNITS
USER 9 is a concatenated field. The first letter (Y or N) indicates if the print on schedule check box from the ‘Basic Data’ page of the section has been checked on or off. The letter(s) after the dash indicate if the class section Instruction Mode assigned on the Basic Data Page:
	Instruction Mode
	Description

	CW
	Classroom with Web component

	OC
	Course located off-campus

	OL
	Online course

	P
	Classroom Instruction

	TO
	Televised Course-origination site

	TR
	Televised Course-receive site

	TV
	Televised course

	VV
	Course located at Victor Valley Community College

	WC
	Web with classroom component

	Z
	Zero Unit Instruction


USER 10 is SESSION 
USER 11 is the CLASS NUMBER
USER 12 is an additional combined section indicator

USER 13 is campus

USER 14 is building and room

USER 15 is an import ID
Note: Custom layouts must be set up for each tab (Sections, Rooms and Events). Custom layouts will not “copy” from one tab to the next. Use refresh tool to display custom layouts when moving between all visible tabs including Group tabs.

3.2 Column Widths

Follow the steps below to change the width of any column:
Place your mouse between the column headings on the grid until you see a double line with arrows pointing left and right.

Click and drag until the column is the desired width.

3.3 Column Order

Follow the steps below to change the column order:

Place your mouse on the column heading of the column on the main screen you wish to move.  Click and drag the column to the desired position.

Note: Green double arrows will appear when you click on the column; use them as a guide to where your column will be inserted.


3.4 Choosing a Date Range or Term  to view 
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Section data can be viewed by academic term. You may also choose to view only a portion of a term or multiple terms by setting a date range. Follow the steps below to choose a date range:
Click the Select a date range/term to view icon [image: image38.png]


 in the upper toolbar (you may also select File | Select Dates). The ‘Select Date Range to View’ dialog box will appear.  
Choose the term or date range of information you would like to view.

Click “OK.”
Note: If the viewable date range encompasses two or more terms, another set of tabs will be generated directly below the lower toolbar. These tabs are divided by terms.

3.5 Grouping Options 
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The Section and Event tabs feature a “Group By” and a “Jump To” dropdown menu (to the right of the lower toolbar) that allows you to view your data in various ways. Grouping creates a second set of tabs (and possibly a third, if you select a two-tier group such as “Building/Room”) at the bottom of the main user interface window. 

Follow the steps below to group the database fields:
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From the “Group By” drop-down menu, select the field(s) by which you wish to group the data (in this example, “Building”).
Note: If you have too many tabs to be viewed on the screen, you may scroll through them using the arrow keys [image: image39.png]


 to the right of the tabs. 
Select a value from the “Jump To” drop-down menu to go to a specific value set in your grouped data.
4.0 Scheduling an Individual Section
The Available Rooms Tool

The Available Rooms tool will search to find a room that meets the user-defined preferences for a section. Use the Available Rooms tool when you need to schedule a room for a class section or re-schedule a section into a different room.

Understanding Preferences

User-defined scheduling preferences allow important subjective factors to influence room selection. They are central to section scheduling.

Weighting

Weights on preferences define the strength of a preference for (or desire to avoid) an attribute. Weights are used as part of the calculation that determines the best room(s) available.

All scheduling preferences except Room Type allow weights from “-10” to “10.” Room Type only allows weights from “1” to “10” because any Room Types not selected are automatically not considered (and therefore do not need to be avoided).

Higher weights (or in the case of the negative weights, lower) mean stronger preferences. A “10” weight means that the selection is ideal. A “5” is half as desirable as a “10.” A “-10” means that the selection will never be considered. Weights from “9” to “1” are considered, but avoided. 

Selecting “limit search to list” on Building and Building and Room preferences will prompt Astra Schedule to only consider the selected attributes.

Note: If you add a preference, it is best to set the weight value to at least “1”; if you leave it at “0” it is just the same as not having it selected at all.

Room Type

The Room Type is the actual configuration of the room. Room Type preferences correspond to Room Types defined in the room file and weights (importance) may be set from “1” to “10.”
Note: At least one Room Type preference must be selected in order to schedule a section. 

Room Features

Room features are room attributes that are a permanent part of the room, such as projection screens, whiteboards, wheelchair access, or special A/V (Audio/Visual) equipment. Only those features that are important in room selection should be defined and selected. Room Feature preferences can be “hard” (weight – 10) or “soft” (weight < 10). If a hard weight can’t be found the ability to assign a room may not be possible. For features that allow quantities, select a desired number of that feature. If this number is required (a minimum) enter a weight of “10” and check the “Minimum Quantity Required?” box.

Note:  Excessive use of room features can limit room selection.

Regions (in development for future use)
A region is a user defined block of rooms and buildings on your campus that may overlap two or more buildings. Each room in your room table can be assigned to one region or to several regions. Ideally, regions should be set up to define preferred groups of rooms or to limit User access to a group of rooms, not to divide the campus into several “mini” campuses or departmental “turf.” Weights can be set from “-10” (avoid) to “10” (strongly prefer).

Building

Certain preferred buildings may be requested. Weights can be set from “-10” (avoid) to “10” (strongly prefer).

Room

Certain preferred rooms may be requested. Weights can be set from “-10” (avoid) to “10” (strongly prefer).

4.1 Using the Available Rooms Tool

Follow the steps below to place an unscheduled section using the Available Rooms tool:

In the Sections tab, navigate to the section you wish to schedule. Image available room’s page 
[image: image77.png]


Double click on the section. The Edit Section Information dialog box will appear.  You must have at least one room type selected in the Scheduling Preferences field “Room Type.”
[image: image78.png]


Click the Assign Available Rooms button [image: image40.png]


 next to the “Building” and “Room” fields in the upper right area of the window. 

The Available Rooms dialog box will appear. The “Available” field (column) will be yellow for rooms that are available for the times and days selected for this section.
Note:  The number in the “Cost” field for a room is a combined (score) of all preferences selected for the section and the percentage of seats filled. The lower the cost, the better the match for the section. Image of available rooms 
Click on the row of the room into which you would like to place the Section. The entire row will be highlighted.
If you have previously created a filter while viewing the daily or weekly room grids, that filter can be applied here using the Filter dropdown menu.

To find available rooms based on actual Enrollment or Max Enrollment, select the appropriate radio button.

Click Select. Clicking this button will automatically schedule the section into the room you have selected. Image of available rooms 
[image: image79.png]


The Conflict Tool Image of clock 
Optionally, click the ‘Clock’ icon [image: image41.png]


 to view the Conflict Tool. Selecting this option will display a new Available Rooms dialog box.  The Conflict Tool shows section conflicts by time for all of the days that the section meets.

Mouse over the bars on the right to get more information on the sections and events that are causing the conflict.

Select a room on the left and click on the Weekly View tab to get a weekly picture of the conflicts in that one room.
5.0 REPORTING
5.1 The Daily Room Grid

[image: image80.png]


The Daily Room Grid allows you to see academic and event bookings for multiple rooms on a single day. To access and use the Daily Room Grid, click the ‘Daily Room Grid’ icon in the upper toolbar[image: image42.png]


. (You may also select Assignment | Daily Room Grid.)  Image of calendar date 
A Select Date dialog box will appear; select the date you wish to view and click “OK.” The Daily Room Grid will be displayed. Image of daily room grid 
With no filters selected, all buildings and rooms will be displayed. Scroll down to view additional rooms and buildings. To view a different date, click on the area displaying the current day, and select a new date from the calendar tool.
Place your mouse over any block on the time grid on the right-hand side of the window to view detailed information on the section or event.
Image of hint information 
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To change the appearance of the information you see when you mouse over, select Options | Hint Information. The Hint Information dialog box will be displayed. By checking the related boxes, select the information you would like to view for sections and events.

Use the Options menu to:

Change the display properties to 15-, 30- and 60-minute blocks of time

Print the grid. For best printing results, set the graphics on your printer settings to "fine."

Change the mouse-over displays

Change the color options
Select Filters | Create Filter or use the Filter icon to filter your list of rooms.  Filters allow only the rooms that meet the selected attributes to be displayed. You may save your filters and re-load them at a later time by selecting Filters | Load Filter. Filters may be turned off by using the Turn Filter Off icon [image: image43.png]


. You may also select a previously-created filter from the Filter drop-down menu. Image of circle with a line in the middle
The grid will base space utilization and overbooked rooms by either actual enrollment or the max enrollment of the section depending on which radio button you select at the top of the screen.

Click on a block in the grid containing a section or event to select it. You may then right-click to access two features:

Jump directly to the record for that section or event

Print a confirmation for that section or event

To create a single-day event, click and drag across the right grid to select a room and time. Then click the Create Event button. This process is discussed in further detail in the Creating an Event topic (Chapter 8, section ten) in this document.

5.2 The Weekly Room Grid

The Weekly Room Grid allows you to see one room’s assignments, one week at a time. To access and use the Weekly Room Grid, click the Weekly Room Grid icon in the upper toolbar[image: image44.png]


. (You may also select Assignment | Weekly Room Grid.) Image of weekly room grid page
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A Select Date dialog box will appear; select the date you wish to view and click “OK.” The Weekly Room Grid will be displayed. Scroll to the room you wish to view. Note: The academic and event bookings for the selected room will appear on the right hand side.

To jump to a different week, click on the area displaying the current week/date range and select the date from the calendar tool. 
To change the appearance of the information you see when you mouse over, select Options | Hint Information. The Hint Information dialog box will be displayed. By checking the related boxes, select the information you would like to view for sections and events.
Use the Options menu to:

Change the display properties to 15-, 30- and 60-minute blocks of time

Print the grid. For best printing results, set the graphics on your printer settings to “fine”
Change the mouse-over displays

Change the color options

Select Filters | Create Filter or use the Filter icon to filter your list of rooms.  Filters allow only the rooms that meet the selected attributes to be displayed. You may save your filters and re-load them at a later time by selecting Filters | Load Filter. Filters may be turned off by using the 'Turn Filter Off' icon [image: image45.png]


. You may also select a previously created filter from the Filter drop down menu.
The grid will base space utilization and overbooked rooms by either actual enrollment or the max enrollment of the section depending on which radio button you select at the top of the screen.

Click on a block in the grid containing a section or event to select it. You may then right click to access two features:

Jump directly to the record for that section or event

Print a confirmation for that section or event

5.3 The Monthly Event Calendar

[image: image83.png]


The Monthly Event Calendar provides a monthly overview of all events taking place on campus. To access and use the Monthly Event Calendar, click the Monthly Events icon [image: image46.png]


.
The Monthly Event Calendar will be displayed. Change the month or year you are viewing by clicking on the Previous Year/Month buttons and the Next Year/Month buttons    [image: image47.png]
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.

Image of two icons, one with two arrows facing left, and another one with just one arrow facing left
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Image of a day view 
Clicking on the Notifications tab shows a monthly view of all automatically generated notifications. Double-clicking on any day gives you a detailed view of all the meetings occurring on that day in the Day View window.  
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Double-clicking on an event in the Day View window displays printable event details in the Details window.

Printable details can be viewed by clicking on the appropriate day, and then clicking on the appropriate notification person. Image of detailed events 
5.4 The Faculty Grid
The Faculty Grid allows you to view instructors’ schedules, one week at a time.  To access and use the Faculty Grid, click the Faculty Grid icon in the upper toolbar [image: image49.png]


.  (You may also select Assignment | Faculty Grid.) The Faculty Grid will be displayed.
[image: image86.png]


Select a faculty member’s name on the left side of the grid or from the drop down menu.  The right-hand side of the grid will display the selected instructor’s schedule. 

To change the dates being displayed, click on the date and select the date you wish to view.
To change the appearance of the information you see when you mouse over, select Options | Hint Information.  The Hint Information dialog box will be displayed.  By checking the related boxes, select the information you would like to view for sections and events.

Use the Options menu to:

Change the display properties to 15-, 30- and 60-minute blocks of time

Print the grid. For best printing results, set the graphics on your printer settings to fine
Change the mouse-over displays

Change the color options
Select Filters | Create Filter or use the Filter icon to filter your list of rooms.  Filters allow only the rooms that meet the selected attributes to be displayed. You may save your filters and re-load them at a later time by selecting Filters | Load Filter. Filters may be turned off by using the ‘Turn Filter Off’ icon [image: image50.png]


.  You may also select a previously-created filter from the Filter drop down menu.  Image of circle with a line in the middle 
The grid will base space utilization and overbooked rooms by either actual enrollment or the max enrollment of the section depending on which radio button you select at the top of the screen.

Click on a block in the grid containing a section or event to select it. You may then right click to access two features:

Jump directly to the record for that section or event

Print a confirmation for that section or event

5.5 Search for Available Room Tool
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The Search for Available Room Tool allows you to view reports and grids that show room availability for sections and events during specific times and meeting patterns. To access and use this tool, in the main user interface window, select Assignment | Search for Available. If you select Rooms, the Find Available Rooms dialog box will be displayed. You may also add the ‘Find Available Rooms’ Icon[image: image51.png]


 to your toolbar. Image of finding available rooms 
This window allows you to choose from four tools:

Event Tool: to view all available rooms for single/multiple meeting patterns

Section Tool: to view or print a list of available rooms for a section meeting pattern

Room Grid: to view or print a collapsed room grid by date range for available times

Report By Standard Days and Times: to view or print all available rooms by Standard Day and Time (std)
Event Tool

The Event Tool allows you to view all available rooms for single/multiple meeting patterns. Follow the steps below to use the Event Tool:

In the main user interface window, select Assignment | Search for Available Rooms. The Find Available Rooms window will be displayed.

[image: image88.png]


Select the radio button next to Event Tool and click the Next button. The Search for Available Rooms window dialog box will be displayed. Image of searching for available rooms 
Select the “Start Time” and “End Time” you wish to check for room availability.

Select the dates you wish to check for room availability. You may select your date range in three different formats using the tabs in the middle of the dialog box.

To select a single or multiple date range, select the Single/Multiple tab and click on each day to highlight it. Click the month buttons to switch months, and the arrows to switch years.

To select recurring days, select the Recurring tab and enter the start and end dates of your date range. Then click on the days of the week, and select the frequency of occurrence.  Example: To check for room availability for every other Wednesday in December, you would select Dec. 1 as a start date and Dec. 31 for an end date. Then you would check the box next to “Wednesday,” and then check the box next to “Every Other Occurrence.”
To select a date that spans a time range, select the ‘Spanning’ tab and enter the start date and end date.  

After you have selected your date range, you may check availability for an individual room or a group of rooms.  

To select an individual room, in the Search Criteria field, check the radio button next to “See if a specific building and room is available,” and then select a building and room.

To select all rooms, or a group of rooms, check the radio button next to “Search for all available rooms.” You may then search for all available rooms for your date range, or you may filter down to Building, Room Type, Region or Minimum Capacity.
[image: image89.png]Endiines




Click the Search button. The Select Rooms for Meetings grid will be displayed. This grid shows the availability of your selected rooms during your selected date range.  The rooms are listed down the left-hand side of the window, and the days and times are listed across the top. If the room is not available for the specific day, that cell in the room row will be highlighted as Not Available.  If you have too many dates selected to fit in the window view, you may scroll horizontally, or you may click the Zoom Out icon. This will shrink the Month/Day, Year, and time headings to allow more columns to fit on your screen.
Click the Close button to close the window. Image for searching meetings rooms 
Section Tool

The Section Tool allows you to view or print a list of available rooms for a section meeting pattern. Follow the steps below to use the Section Tool:

In the main user interface window, select Assignment | Search for Available Rooms. The Find Available Rooms window will be displayed.

[image: image90.png]


Select the radio button next to Section Tool and click the Next button.  The Section/Available Rooms dialog box will be displayed.
Fill out the fields in the upper portion of the window to refine your search by Enrollment, Campus, Start and End Date, Start and End Times, and Days Met.  

You must select a Room Type preference before you search. Click in the “Room Type” field in the Room Preferences area. The Room Type Selection window will be displayed.
[image: image91.png]B
B




Select your Room Type(s) in the drop-down menu(s) and weigh them with the slide bar, if appropriate. Click “OK” to return to the Section/Available Rooms window.
Set preferences at the Feature, Region, Building, or Building and Room level if appropriate.

After configuring all of your preferences, click the Print button. The Report Setup window will be displayed. Select your report destination: Printer, Print Preview, or Save to File. Click “OK.”
Note: It is recommended that you preview the report before printing a hard copy, as these reports can be very large.

Room Grid

The Room Grid allows you to view room availability in grid format by date and time. Follow the steps below to use the room grid: 
In the main user interface window, select Assignment | Search for Available Rooms. The Find Available Rooms window will be displayed.

Select the radio button next to Room Grid and click the Next button.  The Room Report dialog box will be displayed.
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Select the room(s) for which you wish to check availability in the left-hand side of the window. To select all the rooms, select the box next to “All.”
If you want to check room availability for an entire term, select it in the Term drop down menu, or you may select a date range to view by using the Start Date and End Date fields.
Select a start time for the grid display.
If you want the report to generate a list of events and sections assigned to the room after the grid view, select the box next to “Print Details.”
Click on Print button; the Report Setup window will be displayed.  Select your report destination: Printer, Print Preview, or Save to File. Click “OK.”
Note: It is recommended that you preview the report before printing a hard copy, as these reports can be very large.
5.6 Report By Standard Days and Times
The Report by Standard Days and Times option allows you to view or print a report of all available rooms by Standard Day and Time. Standard Days and Times are set up by your System Administrator in the Data Monitor. Follow the steps below to use the Report by Standard Days and Times:
[image: image93.png]


In the main user interface window, select Assignment | Search for Available Rooms. The Find Available Rooms window will be displayed. Image of selecting standard days and times 

Select the radio button next to Report by Standard Days and Times and click the Next button. The Select Standard Days and Times dialog box will be displayed. If you wish to check room availability for an entire term, select it in the ‘Term:’ drop-down menu, or you may select a date range to view by using the ‘Start Date:’ and ‘End Date:’ fields.

Select the Campus, Enrollment, Day(s) of Week, and Start/End Time.  

You must select a Room Type preference before you search. Click in the “Room Type” box under Room Preferences. The Room Type Selection dialog box will be displayed.  Select your Room Type (s) in the drop-down menu(s) and weight them with the slide bar, if appropriate. Click “OK” to return to the Section/Available Rooms window.  

Set preferences at the Feature, Region, Building, or Building and Room level, if appropriate.  

After setting up all your preferences, click on the Print button. The Report Setup window will be displayed.  Select your report destination: Printer, Print Preview, or Save to File. Click “OK.”
Note: It is recommended that you preview the report before printing a hard copy, as these reports can be very large.

5.7 Export to Excel Feature
Any data that is viewed in the main user interface window (e.g. Sections, Events,
Rooms) can easily be exported to an Excel spreadsheet using the Export Grid button [image: image52.png]


 in the lower toolbar. This will export only the records you have viewable, so if you have grouped a subset of data in the Group By drop-down menu, only the displayed group will be exported. 
Additionally, you can select individual records and groups of records to export by holding the Ctrl key and selecting specific records in the main user interface window, and then clicking the Export Grid button. 
[image: image94.png]


After clicking the Export Grid button, you will be prompted to save the Excel file.  Assign a name and location for the file; upon successful completion, you will see an “Export done” message. Image of export alert 
5.8 Standard Reports

Generally, standard reports are section, event, room, and resource lists. Not all standard reports are available to all users. The following tables list the basic standard reports that are packaged with Astra Schedule:
Event Reports

	Report Name
	What it Details

	Events by Building, Room and Date Range
	A list of events meeting during a selected date range, sorted by building and room

	Events by Customer
	A list of events sorted by customer name and filtered by date range

	Events by Date and Time
	A list of events for a date and time range

	Events by Date Range with Setup and Notes
	A list of events by date range with setup and teardown times and notes included

	Events by Date, Building and Room
	A list of events for a selected day, sorted by building and room

	Events by Selected Customer
	A list of events by date for a selected customer

	Events by Event Status and Date Range
	A list of events sorted by the event status and date range

	Events by Selected Event Type
	A list of events by a selected, user-defined event type

	Events by Event Type
	A list of events sorted by the user-defined event type

	Events with Resources by Date
	A list of events with resource bookings, sorted by date range

	Events with Resources by Resource Name
	A list of events with resource bookings, sorted by the resource name


Resource Reports

	Report Name
	What it Details

	Grouped Resources by Category
	A list of resource groups organized by category

	Pooled Resources by Category
	A list of resource pools organized by category

	Resources by Category
	A list of individual resources organized by category

	Resources by Selected Category
	A list of individual resources for a selected category


Room Reports

	Report Name
	What it Details

	Room List by Building
	A room inventory grouped by building

	Room List by Region
	A room inventory grouped by region

	Room List by Room Type
	A room inventory grouped by room type

	Room List by Selected Building
	A room inventory for a selected building


Section Reports

	Report Name
	What it Details

	Sections By Building and Room
	A schedule of sections by building, room, date, day and time. This report supplements the scheduling data in the Weekly and Daily Room Grids

	Sections by Instructor and Date Range
	A schedule of sections for a date range, sorted by instructor

	Sections by Instructor and Term
	A schedule of sections for a specific term, sorted by instructor

	Sections by Selected Instructor and Date Range
	A list of sections for a selected instructor for a date range

	Sections by Selected Instructor and Term
	A list of sections for a selected instructor for a specific term

	Sections by Selected Subject and Date Range
	An list of sections for a selected subject and date range, sorted by course number

	Sections by Selected Subject and Term
	An list of sections for a selected subject and term, sorted by course number

	Sections by Subject and Date Range
	A list of sections for a date range, sorted by subject

	Sections by Subject and Term
	A list of sections for a term, sorted by subject

	Sections with Exceptions by Date Range
	A list of sections with exceptions for a specified date range, sorted by subject

	Sections with Exceptions by Term
	A list of sections with exceptions for a specified term, sorted by subject

	Sections with Resources by Date Range
	A list of sections with resource bookings for a specified date range

	Sections with Resources by Date Range and Resource Name
	A list of sections with resource bookings for a specified date range, sorted by resource name

	Sections with Resources by Term
	A list of sections with resource bookings for a specified term

	Sections with Resources by Term and Resource Name
	A list of sections with resource bookings for a specified term, sorted by resource name


5.9 Viewing a Standard Report

Follow the steps below to view and print a standard report

[image: image95.png]


In the main user interface window, select File | Standard Reports. The Select Standard Report dialog box will appear.
Select a standard report from the report tree and click Print or Save to File. Selecting Print will give you the option to print or see a preview. Selecting Save to File will display the Save Report To window.
If you are saving the file, in the Save Report To window, select either RTF (Rich Text Format) or HTML (Hyper Text Markup Language) format, enter a filename, and click the Browse button to select a location.

Click “OK.”
5.10 Reporting Tool

In addition to the 34 Standard reports provided by Astra Schedule, you may create your own User reports by using the Reporting Tool. User reports may be created from scratch, by cloning any of the existing Standard reports, or by importing reports created by other Astra partners. A Preview button in the Report Builder makes it easy to see your report results as you make changes.

Any User reports that you create will be visible to other Astra Schedule Users on your campus who have appropriate User account permissions. Since User reports may be viewed by other Astra Users, it may be good practice to organize any reports that you create into a report group bearing your name. Additionally, all reports must have unique names, so adding your initials or first name to the name of each report you create may also be helpful.

Creating / Editing a Report

[image: image96.png]


Follow the steps below to create a new standard report:
To open the reporting tool, in the main user interface window, select Configure | Standard Reports. The Select Report dialog box will appear. 
Two tabs at the top of the Select Report dialog box allow you to toggle between the Standard reports provided by Astra Schedule and any User reports you or other Users may have created. 
To create a new report, you may clone one of the Standard reports, edit and rename an existing User report, or create a brand new report. 
[image: image97.png]


To clone a Standard report, toggle to the Standard Reports tab in the Select Report dialog box. Double-click on the report you wish to clone. The Report Builder dialog box will open with the settings of the Standard report listed by default. The report name will include the phrase “Copy of” to indicate that you are cloning a report. At this point you may continue to edit the report using the steps listed below. Image of report builder 
To edit an existing User report, toggle to the User Reports tab in the Select Report dialog box. You may either double-click on the report you wish to edit, or highlight the report and select the Edit button. The Report Builder dialog box will open with the settings of the User report listed by default. Because each report must have a unique name, the report name will need to be changed before the new report may be saved. At this point you may continue to edit the report using the steps listed below.

Image of new report page 
[image: image98.png]


To create a brand new report, toggle to the User Reports tab in the Select Report dialog box and Select the New button. The New Report dialog box will appear. 
 There are five report templates that may be used to create a new report: Event Meetings, Event Meetings w/Resources, Event Meetings w/Contact Information, Section Meetings, and Sections Meetings w/Exceptions. The Use a Report Template option makes the report creation process easier, as tables, table joins, and fields to be used in the report are pre defined. Of course, any template defaults may be changed.  Alternately, a report may be created from scratch, with no pre defined defaults, by selecting the Create an Advanced Report option. 
Click “OK” to display a blank Report Builder dialog box. At this point you may continue to edit the report using the steps listed below.
The Report Builder dialog box, in which reports are created and edited, is divided into a header area and tabs. The header contains fields for the Report Name, Title, and Report Group Name.  
Report Name: Enter the name of the report as it will be displayed in Astra Schedule. Each report must have a unique name, and you will be alerted upon saving if your report's name is already in use. Adding your initials or first name to the name of each report you create may be helpful in creating a unique report name.

Title: Enter the text that you would like to display at the top of the report when it is viewed or printed. If you have defined any run-time variables (discussed later in this topic) you may click on the [image: image53.png]


 icon to add those variables to the report title. Image of icon with tree dots 

The Report Group Name drop down menu lists the groups under which your report may be listed in the File | Standard Reports drop down menu. The Standard reports are organized into four groups by default - Events, Resources, Rooms and Sections. You may choose one of these groups from the drop-down menu for your report, or you may type in your own group name. Since User reports may be viewed by other Astra users, it may be good practice to organize any reports that you create into a report group bearing your name. 
The Report Builder is divided into six tabs - Select Tables, Select Fields, Group/Sort, Filter, Formatting, and Miscellaneous. - one for each step of the process.  The tabs may be edited in order or edited individually. Upon opening an existing report, cloning a Standard report, or creating a new report, the Report Builder dialog box display the Select Tables tab.  
[image: image99.png]


On the left-hand side, all tables which may be included in your report are displayed. Any tables displayed on the right-hand side are already included in the report.  You may move tables between the panes by using the right and left arrows, or by dragging and dropping the table names from one side to the other. The “Ctrl” and “Shift” buttons may be used to select multiple tables to move at one time.     Image of report builder page 
Once you have selected the tables you wish to include in your report, click the Next arrow to progress to the Select Fields tab (or click on the tab itself).

Image of report builder result page
[image: image100.png]


The Select Fields tab displays a box for each of the tables in the report and a list of fields in the tables.  Check the box next to any field you wish to use in the report. Be sure to check not only fields that are to be displayed, but also “invisible” fields that may be used for sorting or filtering purposes only.  
To create a join between two tables, drag a field from one table and drop it on the corresponding field in a second table. For assistance in determining field equivalency for the purposes of table joins, please contact the Astra Technical Support team or refer to the Astra Entity Relationship Diagram (which may be acquired from Technical Support).  
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To delete a table join, double click on the background of the Select Fields tab for a list of current joins. Select the row of the join you would like to delete and click the Delete button. Image of view links 
[image: image102.png]


Once you have configured the fields you wish to include in your tables, click the Next arrow to progress to the Group/Sort tab (or click on the tab itself).

The Group/Sort tab allows you to define up to two fields by which you wish to group your data, along with any number of fields with which to sort the report.  Image of report Builder page

Grouping/Sup-Grouping: Use the drop- down menus to select a group and, optionally, a subgroup field.  

Check the box labeled “Page Break between Groups” to start each group on a new page in the report. If you select a field by which to subgroup the data in the report, you may configure it in the same way you did the grouping field.

If you would like the group label to display, check the box labeled “Show Group Header.” If you display the group header, you may click the [image: image54.png]


 icon next to the “Header Font” field to change the font characteristics of the header.  Enter a header indent, if desired, in number of inches.
For many fields, you will have the option of enabling footer for the group. For example, footer with the operation of “Count” will total all items in a group on the report. To enable footer, check the box labeled “Show Group Footer” and configure the font characteristics and indent as you did for the header.

Sorting: You may select multiple fields by which you wish to sort the data as it is displayed in your report. The lower portion of the Group/Sort tab contains two panes, labeled “Available Fields for Sorting” and “Sort Order.” All fields used in the report are listed in the “Available Fields for Sorting” pane. The fields by which the data will be sorted are listed in the “Sort Order” pane. Fields may be moved between the panes by using the right and left arrows between the panes, or by dragging and dropping the field names.  

By default, the two fields that you have chosen for grouping and sub grouping will be the first two fields listed in the “Sort Order” pane. You may reorder the remaining fields by using the up and down arrows next to the “Sort Order” pane.

Image of report builder

All sorts may be performed in either ascending or descending order. To change a sort from ascending to descending, click on the word “Ascending” next to the field name and select “Descending” from the drop-down box that appears. 
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Click the Next arrow to progress to the Filter tab (or click on the tab itself). The Filter tab is the location for defining static and runtime variables for the report. A static variable is a field value that is defined during the report's creation and cannot be modified when the report is run.  A runtime variable is a field value that is defined by the User at the time of running the report. For example, a report which lists all scheduled events occurring in a building of the User's choosing would require both a static and a runtime variable. The static variable would be the “EVENT_STATUS” field with a value equal to “Scheduled.” The runtime variable would be the “BUILDING” field with the building to be chosen by the User from a drop-down list during the process of running the report.  

To set a static variable, click the [image: image55.png]


 icon in the Static Variable column next to the field for which you wish to set the value. In the dialog box that is displayed, place the radio button next to the appropriate expression and enter the target value for the variable. You may set up to three static variables for any field in the report. Click “OK” to save the settings. An expression representing your variable will display next to the field name in the Filter tab.
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To set a runtime variable, click the [image: image56.png]


 icon in the Runtime Variable column next to the field for which you wish to set the value. In the dialog box that is displayed, place the radio button next to the appropriate expression and enter a caption to instruct the User about choosing the variable when running the report. You may set up to three runtime variables for any field in the report. Click “OK” to save. An expression representing your variable will display next to the field name in the Filter tab. Image of report
Click the Next arrow to progress to the Formatting tab (or click on the tab). The Formatting tab allows you to configure various settings related to the fields displayed in the report. Each field represents a column of data on the report. The fields may be reorganized by dragging and dropping one or more fields to a different location in the order.

The following table describes the options in the Formatting tab:

	Option
	Result

	Show
	Check this box to display this field on the report.

	In Group 1 Header
	Check this box (in conjunction with the “Show” checkbox) to display this field not as a column, but under the “Group By” header.

	In Group 2 Header
	Check this box (in conjunction with the “Show” checkbox) to display this field not as a column, but under the “Sub Group By” header.

	Display Name
	The name of the field as it will appear in the column title of the report; defaults to the field label in the table.

	Column Width
	Width, in inches, of the column on the report.

	Title Justify
	Justification of the column title.

	Column Justify
	Justification of the column data.

	Group By
	View only; a "1" indicates the primary grouping field, a "2" indicates the sub grouping field, and a "0" marks fields not used for grouping.

	Sort
	View only; displays whether this field is used as an ascending or descending sort field.

	Static Filter
	View only; displays the static filter expressions that exist for each field in the report.

	Runtime Filter
	View only; displays the runtime filter expressions that exist for each field in the report.
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Click the Next arrow to progress to the ‘Miscellaneous’ tab (or click on the tab itself).

The Misc. (Miscellaneous) tab provides various options to change the look of your report. To change the font characteristics of the column title, or column data, click the [image: image57.png]


 icon next to the Title Font, Column Title Font, or Column Font fields.  Three types of borders are available for the column titles and the column information: No Lines, Top and Bottom Lines, and Full Box. Place a check in the box next to the desired style in both the Column Title Box and Column Box areas.
In the “Report Access Level” area, place the radio button next to the desired privacy level of the report. The following three security levels can be assigned to reports: Public, Semi-Private, and Private. Users, in turn, are given access to view reports based upon these same levels. Users are allowed to view events and reports marked at their security level or lower (exempli gratia, Users with private level viewing privileges can view every “private,” semi-private and public report).

The following table describes the remaining options in the upper half of the Formatting tab:
	Option
	Result

	Print Report Heading
	Check this box to print the report heading, if configured, above the title of the report.

	Print Title Every Page
	Check this box to print the report title (and heading, if enabled) on each page of the report.

	Print Page Numbers
	Check this box to print page numbers on the report.

	Print Today's Date
	Check this box to print the date the report was run on the report.

	Landscape
	Check this box to print the report in the landscape (11 x 8.5 inch), rather than portrait (8.5 x 11 inch), orientation.

	Column Indent
	Enter the amount of column indent in number of inches.

	Total Width
	The width of the report, including all indents and fields, in number of inches. Ideally, this value should not exceed 8.5 inches for printing in the portrait orientation, or 11 inches for printing in the landscape orientation.


Configuring the Report Heading

It is possible to design a report heading which can be, optionally, printed at the top of each report. Follow the steps below to configure the report heading:
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In the main user interface window, select Configure | Standard Reports. The Select Report dialog box will be displayed.  Image of report heading showing an Astra image on top         Click the Heading button to open the Report Heading dialog box. Enter the text you wish to appear in the heading in the fields for “Heading Lines” 1-5.Image of icon with 3 dots 
Click the [image: image58.png]


 icon next to the “Heading Font” field to configure the font characteristics and click “OK.” Using the instructions in the Creating/Editing a Report section of this topic, check the box labeled “Print Report Heading” on the Formatting tab of each report on which you wish to print the report heading.

Importing/Exporting Reports

The reporting tool allows you to export any report formats that you have created to share with others through the Import/Export utility in Astra Schedule. You may also easily import report format that have been created by Users and sent to you for use in Astra Schedule. 

Follow the steps below to export a report using the Import/Export utility:

In the main user interface window, select Configure | Standard Reports.  The Select Report dialog box will be displayed.
[image: image107.png]


Highlight the report you wish to export by clicking on it and selecting the Export Report icon[image: image59.png]


.  The ‘Select Directory to Export to’ dialog box will be displayed.

Navigate to the directory to which you wish to save the report and click “OK” to export the file. The file name will be the same as the report name and the file will have “.acr” as the extension. For example, a report named “Events by Customer” will be saved as, “Events by Customer.acr” in the specified directory.

Follow the steps below to import a report file into the reporting tool:

In the main user interface window, select Configure | Standard Reports.  The Select Report dialog box will be displayed.
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Click the Import Report icon [image: image60.png]


 to display the Select Report to Import dialog box. 

Navigate to the directory where the report file is located, select the file from the list and click “OK” to import the report. 
Optionally, if there are multiple report files to be imported into one directory check the box labeled “Import all Report files in this directory” and click “OK.” 
The imported report can be found in the Select Report dialog box, on the User Reports tab.  The imported report will carry the same name as the report file: 
Note: Upon import, you may receive a message indicating that a report of the same name already exists. As all reports must have unique names, you will have to change the name of the existing report before importing the new one.

5.11 Custom Reports

Custom Reports are space utilization reports that require the installation of “Crystal Files.” (This option is available during the Astra Schedule client installation.) Seven space utilization reports accompany the Astra Schedule package. To view Custom Reports, in the main user interface window, select File | Custom Reports. The Select Report window will be displayed.  Highlight the desired report and click the Print button. All sections that are displayed in your Sections tab will be used to calculate the report figures. To change the sections included in the report, redefine your time or date variables from the File | Select Dates drop down menu.

Note:  Reports may be created or edited using a licensed version of Seagate Crystal Reports.

5.12 Interpreting Custom Reports

There are seven custom, space utilization reports packaged with Astra Schedule. Following is an explanation of the data and fields in each custom report:

The Space Utilization custom report provides utilization information about all buildings and rooms on campus. The following table describes the data presented in the Space Utilization custom report.
	Field Title
	Utilization information provided

	Building
	Building name

	Capacity
	Number of seats in the room

	Max. Enrollment
	The average maximum enrollment of all the sections using that room.  Example: If two sections are using that room during a term, one with a maximum enrollment of 20 and another with a maximum enrollment of 30, the Max. Enrollment field in that report will be 25.

	Station Fill
	The percentage of the average Max. Enrollment as compared to the Capacity.  For example:  If the Capacity of a room is 50, and the average Max Enrollment is 25, the Station Fill will be 50%. 

	Room Hours
	The number of hours during any given week in which that the room has class.

	Room Hour Utilization
	Percentage of Room Hours as compared to the number of total hours that are allowed in a standard week.  By default, a standard week is 40 hours, so if your Room Hours are 10, the Room Hour Utilization will be 25%.  However, if you have customized your standard week from the Configure | Standard Week drop-down menu in Astra Schedule, the Room Hour Utilization figure will be calculated based on the number of available hours in your standard week.

	Contact Hours
	The number of student contact hours in this room in an average week.  This number is generated by multiplying Max Enrollment by Room Hours.

	Contact Hour Utilization
	Comparison of the number of actual contact hours by what the total amount of contact hours would be (if the room was full all week long).  Thus, if your actual contact hours are 250, and the total possible contact hours for that room are 1000, the Contact Hour Utilization will be 25%.



The Space Utilization by Building custom report provides identical information to the Space Utilization custom report, but for a specific building and its rooms.

The Scheduling by Time/Day/Dept custom report provides information about when each Department (Subject) is offering classes. It is broken down by hour of day, and day of the week. Decimal numbers are displayed if classes start at 12:10 or 12:20, etc., and portions of hours must to be included in the calculations.

The Scheduling by Time/Day/Dept Summary custom report is similar to the Scheduling by Time/Day/Dept custom report; this report also provides information about when each Department (Subject) is offering classes. However, it is broken down more generally, by time of day (Morning, Afternoon, Evening), and by day of week.
The time of day categories are defined as follows:

Morning = the six-hour period between 8:00am and 1:00pm

Afternoon = the five-hour period between 1:00pm and 6:00pm

Evening = the four-hour period between 6:00pm and 10:00pm

The Scheduling by Time/Day/Room custom report displays room utilization by time of day for an entire week. As with many of the custom reports, decimal numbers are displayed if classes start at 12:10 or 12:20, etc., and portions of hours need to be included in the calculations.

Example: If Art 110 occupies a room on Monday and Wednesday from 10:00am to 11:00am (for a total of two hours), and Art 220 occupies the same room on Friday 10:10am to 11:00am (roughly 0.8 hours), a total of 2.8 hours of class time for that week is calculated during that time block for that room. Ideally, the largest number listed for any given one-hour period should be seven, indicating that the room is occupied all seven days of the week during that hour-long period. However, numbers larger than seven are not uncommon, and may occur if sections are double booked or cross-listed in that room. If a classroom is double-booked or cross-listed, the report counts multiple hours of class time for each one hour time block.

The Scheduling by Time/Day/Room - Summary custom report is similar to the Scheduling by Time/Day/Room custom report; this report also provides room utilization by time of day for an entire week. However, it is broken down more generally, by time of day category (Morning, Afternoon, Evening) and day of week.
The time of day categories are defined as follows:

Morning  
The six-hour period between 8:00am and 1:00pm

Afternoon  
The five-hour period between 1:00pm and 6:00pm

Evening  
The four-hour period between 6:00pm and 10:00pm

The Space Utilization by Room Type/Size custom report is similar to the basic Space Utilization report, but it provides information about room utilization for rooms of a particular room type and size.

The following table describes the data presented in the report:

	Field Title
	Utilization information provided

	Room Type
	The category (type) of room.

	Size Category
	Categories created by Astra Schedule to group the rooms by size.  The numbers correspond to the range of seats in the room (exempli gratia, 1-15, 16-25, 25-50).

	Capacity
	The average number of seats of all the rooms in that Size Category.

	Max. Enrollment
	The average maximum enrollment of all the sections that are meeting in the rooms in that Size Category.

	Station Fill
	The percentage of the average Max. Enrollment as compared to the Capacity.  For example:  If the Capacity of a room is 50, and the average Max. Enrollment is 25, the Station Fill will be 50%.

	Room Hours
	The number of hours during any given week in which the room has class.

	Room Hour Utilization
	Percentage of Room Hours as compared to the number of total hours that are allowed in a standard week.  By default, a standard week is 40 hours, so if your Room Hours are 10, the Room Hour Utilization will be 25%.  However, if you have customized your standard week from the Configure | Standard Week drop-down menu in Astra Schedule, the Room Hour Utilization figure will be calculated based on the number of available hours in your standard week.

	Contact Hours
	The number of student contact hours in this room in an average week.  This number is generated by multiplying Max. Enrollment by Room Hours.

	Contact Hour Utilization
	A comparison of the number of actual contact hours by what the total amount of contact hours would be (if the room was full all week long).  Thus, if your actual contact hours are 250, and the total possible contact hours for that room are 1000, the Contact Hour Utilization would be 25%.



The Section Preferences report displays room scheduling preferences that have been applied to section records. 

The Course Preferences report displays room scheduling preferences that have been set at the Course level. 

The Instructor Preferences report displays room scheduling preferences that have been set at the Instructor level.

The Subject Preferences report displays room scheduling preferences that have been set at the Subject level.

The Resource_ Report displays Resource scheduling by day/building (select single date).

The Resource_Report2 displays Resource scheduling by date range (select date range, sorted by date and time).
The Space Combo report displays space utilization for sections and events. 

The Time Day Bottleneck report displays space utilization by Room Type/Day/Time with bottlenecks bolded. 
5.13 Other Reports

Astra Schedule has several additional reporting tools that allow you access to information regarding your campus schedules and room utilization.
In the main user interface window, in the File drop down menu the following reports may be generated:

Double Booked Sections/Events Reports

Double Booked Instructors Reports

Overbooked Room Report/Sections (attendance and room capacity)

Overbooked Room Report/Events (attendance and room capacity)

Invalid Cross Listed Sections Report (room, times, days and/or dates do not match)

For each of these reports, double-clicking on any row will automatically display the corresponding section or event.  (Note: only Admin. Users may utilize this feature.)
5.14 [image: image109.jpg]


Combo Reports

Combo Reports are lists of sections and events that can be filtered in a number of ways and exported to Excel, if desired. Sections and events are first filtered by campus, and then may be further filtered by date range and building/room. Follow the steps below to run and/or print a Combo Report:
In the main user interface window, select File | Combo Reports. The Course Schedule by Day dialog box will be displayed. Use the Campus drop down menu to select the campus on which you wish to filter. If you wish to view data for all campuses, select “All” from the Campus drop down menu.  

Use the calendars to choose a “Start Date” and “Stop Date.”
Select a building from the Building drop-down menu; optionally, select a room from the Room drop-down menu. Note: if you wish to view data for all buildings, leave the Building drop-down menu empty.  
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Select the desired room you wish to view from the Room drop down menu. Note: if you wish to view data for all rooms, select “All.” Image of drop down men
Click Re Calculate to create the report. Your data will be displayed in the lower portion of the window. The data may be sorted by clicking on the header for any row. The row you have sorted will be indicated by an Up arrow icon[image: image61.png]
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You may change the order in which the data is displayed by clicking and dragging the row’s header (in this example, Subject/Reservation). 
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The data may also be grouped by clicking and dragging the row’s header into the gray area above the data display (in this example, by Title). To remove a sort, select the Remove Sort icon [image: image62.png]


 in the toolbar above the data display. Image of the numbers one, two, and three in a box as an icon Image of two arrows facing left 

The data may be navigated using the blue directional arrows.  The double arrows [image: image63.png]


 enable you to jump to the first or last rows. Image of sheet of paper with an X in the middle 
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If you wish to export your combo report to Excel, select the Export Grid icon [image: image64.png]


 in the toolbar above the data display. Input a file name and save location.

To print the report, select the Print icon in the toolbar above the data display.  The Print Preview window will be displayed.                  Image of two reports 

Image of design report icon as shown as a screw nut
The report may be modified by selecting the Design Report [image: image65.png]E-)



 icon. The Format Report dialog box will be displayed. On the View tab, you may select if you wish to display headers, footers, captions, etc. On the Behaviors tab, you may opt to view the groups and details of your report if desired. The Formatting tab provides a number of options for your report’s look and feel. Once you have made the desired selections, click “OK” to return to the Print Preview window.

Additional icons are available to aid in the formatting of your report, such as Page Setup, Background, Shrink to Page, etc. Once you have made any desired formatting changes, select the Print icon to print your report.  
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